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Introduction

N

odal is software for composing
music, interactive real-time
improvisation, and a musical tool
for experimentation and fun. Nodal uses a
new method for creating and exploring
musical patterns, probably unlike anything
you’ve used before. Using circles and lines
with arrows, Nodal represents a view of
music that emphasizes musical elements
(such as notes, pitches, rhythms,
dynamics) and the interconnection
between them. Making music in Nodal
involves designing processes that
generate musical sequences. It is a
generative method in that it creates music
from these elements and processes.
Instead of describing music as a fixed
progression or path from one musical
element to the next, Nodal allows for the
possibility of multiple pathways between
musical elements. Creative musicians
know that music is not made up of a fixed
series of ideas: any given piece of music is
merely one representation of many that
can be drawn from the musical material at
hand. By representing and generating
music differently, Nodal offers users the
chance to work in an intuitive and direct
way with the processes of music creation.
In Nodal users create networks of nodes
that are connected by edges (in graph
terminology nodes are points in space and
edges are connections between them).
Nodes and edges can be given various
musical parameters in the form of MIDI
information that can be read by software
agents called voices. Voices move around
a network reading MIDI information such
as note or continuous controller messages
as they go. Voices are associated with a
MIDI channel and output port so that they
can send the MIDI messages they read to
any MIDI instrument that you choose. Also
the voice’s MIDI stream can be recorded
into a DAW so it can be edited or
combined with other materials.
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the network and by a number of signaling
rules that are built into Nodal. These rules
provide for a kind of “traffic management”
that guides where a voice will go next. The
time that it takes for a voice to move from
one node to the next is proportional to the
length of the edge between nodes. In this
way, edges represent the duration in time
between note events.
While care has been taken to make Nodal
intuitive to use it is based on a number of
abstract principles that may be new to
many people. You might find that you will
“get” Nodal much more easily by working
through the tutorial. Technical
explanations of the software are given in
the Reference section of this manual.
You will also find a number of examples
included with Nodal. To access these
examples, go to the menu File > Open
Example and select one of the example
files. Once the file is open press the play
button to start playing.
If you’d prefer to watch rather than read,
we have developed on-line tutorial videos
that guide you through using Nodal,
starting with the basics and building up to
advanced topics. These tutorials are
available at:
http://nodalmusic.com/tutorials/
We hope you enjoy using Nodal to
compose and perform your music.

The path that a voice takes through a
network is determined by the structure of
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What’s New in
2.0
Nodal 2.0 is a major internal update to the
software, bringing it up to date with many
modern MacOS and Windows features.
These include:
•

Nodal is now a 64 bit application
and runs on the most recent
versions of MacOS (10.15
“Catalina”) and Windows 10.

•

New, updated retina graphics in
the interface.

•

A new, more flexible licensing
system.

•

Many other internal updates and
bug fixes.

The new licensing system means that
older (Version 1.X) licenses will no longer
work. If you own a valid 1.X license please
contact Nodal Support
(support@nodalmusic.com) for details
and pricing on how to upgrade to a 2.0
license.

What’s New in
1.9
Welcome to Nodal version 1.9. This release
incorporates a number of new features,
which are summarized here.

Scales

Voice groups can now recognize scales.
This is particularly useful when you are
using relative notes and offsets in a Nodal
composition.
To activate this feature, select one or
more voice group players (triangle
symbols in your composition) and check
the “Use Scale” box in the Voice Group
editor as shown above.
You can then select a Key and a Mode
from the drop-down menus. Key sets the
key signature for the player and Mode
selects the set of possible notes within
that key the voice group will play. You can
choose from a variety of common modes,
including Chromatic, Major, Minor, Whole
tone, Lydian, Dorian, and Phygian. For
background information on musical
modes, see this Wikipedia article.
Different voice groups can use different
Keys/Modes, allowing the generation of
harmonies or key changes within a
composition.
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For a quick overview of this feature, load
the file “Keys and Modes” from the File >
Open Example menu.

Edge Signalling
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edge displays the probability of a signal
traversing that particular edge when it
exits the selected node. The output
probabilities will always sum to 1.
The image below shows the same network
but with the Node signalling changed to
Sequential:

In this case the edge labels are in the
following format X(Y), where X is the order
the edge will be traversed, and Y is the
number of times in succession the edge
will be traversed. So for the green edge –
labeled 2(2) –will be the second edge
traversed and it will be traversed twice.

To assist in understanding a Nodal
network structure, you can now display
edge signalling information within the
main document window.

Finally, for a parallel Node, no information
is displayed as all edges are traversed
simultaneously, regardless of the
signaling order or number shown in the
Node editor.

The display of this information can be
turned on and off from the View >
Show/Hide Edge Signalling menu.
The display is active only for sequential or
random nodes with 2 or more exiting
edges. The information displayed depends
on the node type. Here’s a simple
example:

Show Last Note Sent
A new option to show the last note or
notes sent by a node has been added. The
display shows both the note sent and its
velocity.

In this example the selected node is set to
Random signalling, with the probabilities
set as shown in the colour chips. Each

5
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start or stop and then hold down the right
mouse button (or Control-Click on Mac)
and select start or stop.
New example files have been added for
this release.
The selection behavior has been modified
for multiple selections.
You can enable or disable this option via
the View menu or using the keyboard
shortcut Shift-⌘-L.

Voice Group Muting
Individual voice groups’ MIDI output can
now be muted at any time. The voice
group will continue to play, but it will not
output any MIDI information.
To toggle voice group muting select the
voice group(s) you want to toggle and then
Right-click (or Control-Click on Mac) and
select “Mute” from the menu.

Relative offsets have been changed when
using Scales. Offsets of +0 and –0 can be
used to snap to the closest legal note in a
scale.

Compatibility
Nodal is compatible with MacOS 10.6 and
higher. As of this release we no longer
support OS releases prior to 10.6.
The Windows version will run under
Windows Vista, 7 and 8.

Alternatively you can click the “Mute”
check box in the voice group editor.

Note that muted voice group triangles are
displayed as dashed, and likewise a node
being played by a muted voice group
highlights with a striped pattern to
distinguish it from unmuted signals.

Other New Features
You can now start and stop individual
voice groups from context menu. To do
this, select the voice group(s) you want to
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What’s New in
1.8
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in 1.8, files created or saved in 1.8 will not
work correctly when read into previous
versions of Nodal.
The format for specifying a note is simple:
NOTE : VELOCITY : DURATION

Note Lists
Nodal 1.8 incorporates a number of
improvements and new features from 1.7.
The most important change is the new
note list editor that consolidates separate
pitch, velocity and duration lists from
previous versions of Nodal.

The VELOCITY and DURATION
components are optional. As with prior
versions, specification may be absolute or
relative, so the following are all valid note
specifications:
C3

C3:55

C3:75:150%

+5

-12:96:*2

+0:-10:50%

Relative and absolute values can be mixed
in a single note specification. For pitch
and velocity, relative values are added or
subtracted (+ or –). For durations, relative
values may also be multiplied or divided.
If you don’t specify a velocity or duration,
the current value of the playing voice is
used. For starting nodes, the default value
is specified in the Initial Voice settings in
the Voice Group editor.

The new note list allows specification of
note events, which can optionally include
velocity and duration. Additionally, notes
can be grouped in hierarchical sets and
played sequentially, randomly or in
parallel. This allows, for example, a single
node to play a chord (or set of chords).
Nodal 1.8 will read files created with
previous versions of Nodal and convert
them automatically to this new format.
Note that because of the new functionality

You can also group notes together by
placing brackets around them. Different
brackets allow notes to be played
sequentially (round brackets ‘(‘ ‘)’), in
parallel (square brackets ‘[‘ ‘]’) or
randomly (curly brackets ‘{‘ ‘}’). Brackets
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may be nested to as many levels as you
need. Some examples:
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with an orange rectangle.

[C3 E3 G3] // play a C major chord
{+0:30 +0:60 +0:90 +0:120} // play the

previous pitch with velocity randomly
selected from the values shown
(+3:100:100% +5:100:200%
+7:100:400%) // play the three notes

sequentially with relative pitch increases
of +3, +5 and +7 semitones and increasing
durations
{
[+0 +3 +5] [+0 +5 +7] [+0 +7 + 12]
} // randomly play from the 3 specified

relative chords.

For relative chord sequences the first
pitch in the list becomes the new pitch for
the voice traversing the node, so in the
example above it remains unchanged
(since the first element of each chord is
always +0).
Notes listed without brackets are played
sequentially.
You can enter comments for a line in the
Note entry by prefixing them with // (like
comments in Java or C++). This can be
useful for documenting specific
sequences, or in a live performance when
you want to turn different sequences on or
off quickly.
While you enter note sequences, your list
is continuously parsed and checked if it is
valid. Notes will be automatically changed
to upper case, but you can enter them in
upper or lower case. An invalid sequence
will cause the Notes list border to flash

In the example above the closing ‘}’
bracket is missing (notice the orange
rectangle indicating the error). As soon as
a correct note list is entered, it is activated
for that node and will be used when
playing (there’s no need to hit RETURN or
any other key.
The Note editor also has syntax colouring
and auto-completion (hit the TAB key to
add default velocity and duration fields).
You may be interested to know that
internally Nodal takes your note
sequences and turns them into a selfcontained Nodal network, with the entire
network represented by a single node.
You can also enter notes using a MIDI
keyboard. To enter notes sequentially,
play them one at a time. To enter chords
hold down the chord as you would
normally play it.

Other New Features
The default velocity for new notes has
been increased to 96 (from 64).
User interface and usability improvements
have been made to the edge editor.
New “tooltip” information has been added
for nodes and edges (to see the tooltip,
hover your mouse over the element of
interest for a few moments).
The "Add Edge Tile" menu is now sorted
by creation order and new colours have
been added:
8
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A colour-blind friendly pallete can now be
configured via the application’s
preference file (Mac) or registry (Win) by
settings "AlternateColorPalette" as true.
The default is false (implied by the
setting's non-existence). It may be set on
the Mac from the terminal: “defaults
write edu.monash.cema.Nodal
AlternateColorPalette true”

Numerous bug and compatibility issues
have been fixed.
Nodal 1.8 is fully compatible with Mac OS
X 10.7 (Lion), but also works under 10.6
(Snow Leopard) and 10.5 (Leopard).

9

Tutorial
Working with Nodal
Nodal can make sound by addressing your
operating systems’ built in synthesizer.
For more professional sound sources
Nodal can send MIDI information to
software synths or to external hardware
synths by assigning the appropriate MIDI
ports. Software synths are typically found
in many DAW packages such as Ableton
Live, Cubase, Logic, and Digital Performer.
Nodal can also accept MIDI input for node
parameter entry. In the tutorial below we
will assume that you do not have a
software synth or a MIDI keyboard.
Making a simple network
1.

Open Nodal.

2.

Click on the Node & Edge tool (⌘-3¬*) as
shown above.

5.

This node will respond with a green ring
informing you that you have made a
connection.

6.

¬

3.

Click on the grid to make a node.

4.

Click on the first node, hold and drag
to make an edge connecting to
another node.

⌘-3 is the keyboard shortcut for this function: hold
down the command and 3 keys (Mac) or Ctrl and 3
(Windows) simultaneously.

Add two more nodes. To form a closed
circuit, make an edge from the 4th
node (just as you have been doing)
and drag it up to the 1st node that you
made.

Click on the Voice Group tool (⌘-4) then
add a Voice Group Triangle by clicking

Nodal 2.0 Manual

in the middle of the first node as
shown.

7.
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8.

Keep the program playing and click on
the Selection tool (⌘-1). Then select
one of the nodes.

9.

In the Node inspector window change
the pitch in the note in the Notes List
to D3.

Press the Play / Pause button (or press
the space bar on the keyboard)

You should hear middle C (C3 in MIDI)
being played continuously. As each note is
played, a node will flash. You can see what
pitches are entered into a node by
hovering over them with your mouse
cursor.
Editing Pitch Information

You should now hear 3 nodes sounding
the pitch C3 and 1 node sounding D3.

10. Select another node and change the
Notes to a list: F3,B3,A3 (enter these by
typing the notes and hitting TAB to
add velocity and duration
information).
Note that you can see the note list for a
particular node by hovering over it with the
mouse.
You will now hear a more complex
sequence of pitches: 2 nodes sounding
C3, 1 sounding D3 and 1 that cycles
through the pitches F3, B3, and A3. Note
that each node also has a list for MIDI
velocity that can be specified as a list in
the same way as pitch.

11
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Editing Rhythm
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Changing Output Edges

The circuit, or network, that you have just
made consists of 4 nodes arranged in a
square. The square represents a cycle of 4
beats so we could say that the music is
currently in 4/4 time.

12. Add another edge by clicking on the
Node & Edge tool (⌘-3) then click, hold
and drag from the middle of node c in
the figure, to the middle of node b.
a.
This produces a more complex series of
node firings:
a, b, c, d, a, b, c, b, c, d ... etc

b.

Node c has two output edges (or
connections), which can be highlighted by
clicking on the node with the Selection
tool. These are designated with the
colours orange and green. Each time node
c fires the output edges are selected in
sequence, orange, green, orange, green, ...
etc.

c.
11. Using the Selection tool (⌘-1), drag the
nodes around to change their
positions in the 4 beat square as
shown above.
You have now produced four rhythms that
occur in 4/4 time. You can however, place
the nodes anywhere on the grid.
Try out different node placements to hear
a wide range of rhythmic patterns. Before
continuing with the tutorial, edit the
network to return to the pattern shown
above in figure c of step11 .

13. Click on the Selection tool and select
node c. Then in the Node inspector
double click on the orange square and
click on the up arrow to change the
value in the box to 2.
This will produce:
a, b, c, d, a, b, c, d, a, b, c, b, c, d ...
This is the result of node c outputting to
orange twice then to green once.

12
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17. Select node e and enter +12 into the
Note list area. It is not necessary to
enter velocity or duration values.
14. With node c still selected, change the
signalling mode to Random as shown,
in the Node inspector.
You will now hear a constantly changing
pattern because the output from node c is
selected randomly. Node c is now marked
with an “x”, indicating random signalling.

The parallel connection at node d results
in both node e and a firing simultaneously.
The loop is continuous again because the
connections between a, b, c, & d are
continuous.

18. With the Selection tool, select the edge
between d and e.

15. Click on the Node & Edge tool and
make a new node as shown above.
Notice that as soon as node e fires the
sequence stops at a dead end. This is
because there are no outputs from e to
connect it to other nodes.

19. Then in the Edge inspector select the
Wormhole option.
20. Press Play / Pause to run the program.

16. Select node d, and in the Node
inspector change the signalling
method to Parallel as shown.
Node d is now marked by the parallel icon
(circle with 2 parallel lines on the bottom
right).

You should hear the network looping
continuously again. Nodes d and e fire
simultaneously, with node e sounding an
octave above (+12 semitones) node d.
Normally the distance between nodes
determines the time between notes.
Wormhole edges however ignore distance
and the connection across them is
instantaneous. So the wormhole
connection between d and e results in
both nodes sounding at once with the
pitch of node e sounding an octave above
node d.
By setting the Note list for node e in 17 to
+12 you specified a relative value in Nodal.
A node with a relative pitch value will play
a pitch transposed up or down from the
13
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pitch of the neighboring node that
precedes it in the sequence. For MIDI
pitch and velocity, relative values can be +
or – any number of semitones within the
MIDI range. You can mix absolute note
values (e.g. C3, D#2) with relative values
(+12,-5). Relative duration will be explained
in section 6 Changing Duration pg 7.

© 2019 SensiLab

Instruments and Voices

21. In the Inspector window, click on the
Instrument icon, as shown above, and
select the orange instrument.

22. Select the Program Change option
(towards the bottom of the inspector
window) and highlight the Program
number. Set this to your desired
General MIDI instrument.
To see the interface for the Nodal
synthesiser choose from the menu:
View > Show Synthesiser
This gives a menu of instruments and
displays the current instrument for each
MIDI channel.

23. In the inspector window add a second
instrument by clicking on the +
button.
24. Select the new instrument (it should
be called “instrument 2” by default).
Then activate the Program Change
checkbox and enter a program
number that is different to the orange
instrument.

14
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the Voice Group inspector select
instrument 2 as shown.
29. Stop, go to start, and restart the
program.

25. Using the Voice Group tool, make
another starting Voice Group Triangle
as shown.

You should now hear the two starting
voices with two different instrument
sounds.
Changing Velocity and Duration

26. If the program is running, stop it by
pressing the Play / Pause button. Then
press the Go to Start button (to the left
of the Play / Pause button).
27. Start the program again.
You should now hear a polyphonic texture
with two parts playing simultaneously. In
Nodal these parts are called voices. One
voice starts at node a, and the other at
node b.

30. Select node d and change the Note list
in the inspector to the values shown
above.
As the program plays, the notes that are
generated by node e have a longer
duration than other notes. Their loudness
(note-on velocity) switches between being
softer (-20) and louder (+20).
Notes are specified by a pitch value,
followed optionally by velocity and
duration values, separated by a ‘:’.
Note duration is, by default, set to 100%.
This is a relative value that relates to the
output edge length. For example, the
duration of notes made by node a, are
100% of the distance/time between a and
b. Beats are represented by lines in the
background grid, so we can see that the
distance between nodes a and b is one
and a half beats.

28. With the Selection tool, click on the
starting triangle for node b. Then in

The duration for notes made by node e
however, is now set to 4. This is a fixed
value and designates 4 beats. Changing
output edge length does not change the
duration time with such a fixed value.
You may have noticed that the edges can
only snap to vertical or horizontal
orientation. This limitation automatically
quantises distance/time to units of full
beats.
15
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Instrument Change

The smaller grid units represent
subdivisions of the principal grid.
Therefore in this tutorial, a beat can be
sub-divided into 4 grid units. To calculate
the duration of an edge, count the total
number of grid units it traverses. For
example the distance from node a to node
b is 4 horizontal grid units and 2 vertical
units. This gives a total or 6 units or 1 and a
half beats. If you hover the cursor over an
edge its length will be given in both
principals (beats) and divisions (divisions
of beats).

31. Create a new node connected to node
a as shown. Set the signalling for node
a to Parallel.

With a little thought, it is possible to create
networks for all time signatures. For
example, 3/4 and 5/4 time signatures are
shown below.

32. Create a new instrument (click on the
+ button in the Instrument inspector).
33. Set the MIDI channel for this
instrument to 10.
It is possible to assign more than one MIDI
channel to a single instrument, so in this
case make sure that only 10 is selected.
You can also hide the grid display (⌘-‘) and
even turn off the grid-snapping feature
(Shift ⌘-‘). Both these options are in the
View menu.
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Continuous Controllers

37. Select the edge from b to c as
shown above.

38. In the Edge Inspector, click on the
Cubic tab in the Continuous
Controllers section.
34. Select node f and, in the Node
inspector, set the Note list to: F1 G1 A1
B1 (there is no need to enter velocities
or durations).
35. Then activate the Instrument Change
checkbox and select Instrument 3 from
the menu, as shown above.
36. Stop, go to start and play the program.
You will now hear a tom-tom percussion
part that is triggered by node a. This is
caused by the use of the Instrument
Change feature that was set for node f.
You may remember that a voice is an
aspect of a Voice Group that traverses a
network producing notes with an assigned
instrument. Instrument Change swaps the
instrument associated with a voice to a
new instrument. This means that once a
voice has encountered an Instrument
Change command it will retain that new
instrument when it continues on to other
nodes. This instrument remains until
another instrument change command is
received.

An editing interface for continuous control
will appear as shown above.
39. Select controller no. 11, Expression
Controller in the MSB menu.
40. Change the controller value curve
as shown above by dragging the
handle on the right of the editor up
to the top of the edit space.
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Voice Triggering

41. Select the edge from node c to d.

Voices can be turned on and off
independently of the play button. This
functionality is similar to that of clips in
Ableton Live which can be triggered in
real-time. There are two ways that voices
can be triggered; 1) using the mouse and
2) using a MIDI note message. MIDI note
messages will not be covered in this
tutorial however information about
triggering using MIDI note messages is
given in the Reference section, see pg 20.
45. Start Nodal running (using either
the start button in the transport
section or the space bar).
46. Check that the Selection tool (⌘-1)
is selected (this is the arrow
cursor).
47. Option-click (Mac) or Alt-click
(Windows) on a Voice Group
Triangle.

42. Create a new control editor and
select Pitch Bend as shown above.
43. Edit the control curve as shown.
To do this you will need to create new
handles. This can be done by clicking in
the edit space. Handles can be deleted by
selecting them and pressing the delete
key.

You will notice it is possible to turn off
voice groups and then turn them back on
using step 47. This method is designed
assuming that voices should be active
when Nodal is started however it may be
the case that it is preferable to start
voices only by triggering them. In order to
do this Voice Group Triangles must be
designated as triggering. Triggering Voice
Group Triangles will only start or stop in
response to mouse clicks or to MIDI note
messages.

44. go to start and play the program.
You should be hearing a note that fades in
every so often (this is the result of the
expression controller) and other notes
that have pitch bend. The duration of the
control curves matches the length, in time,
of the edge to which they are associated.
Nodal allows you to add as many
additional controllers to each edge as you
want. Two-byte and single byte controllers
are supported. Control messages are sent
in the order specified.

48. Select a starting triangle and in
the Voice Group Inspector, enter a
MIDI pitch value (C3 for example)
in the MIDI Pitch List field as
shown above.
49. Press the play button (or
spacebar).
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Notice that the voice group you selected
in step 48 is not active when Nodal is
playing. By entering in the MIDI pitch value
in the triggering section the voice group
was designated as triggering. The voice
group will be active when a MIDI note with
the designated pitch value is sent to
Nodal. This design assumes that
triggering will mostly be done with MIDI
note triggers, however mouse clicking also
works in this scenario.

© 2019 SensiLab

the next beat. The quantization can be
changed to different temporal resolutions
in the Voice Group Inspector.

51. Try triggering voice groups with
different quantization settings by
selecting them in the Voice Group
Inspector shown above.

50. With Nodal still running, Opt-click
or Alt-click on the designated
Voice Group Triangle.
The actual time when a voice group is
triggered defaults to being quantized to

19
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Reference

Overview of the Nodal interface.

Basic Elements and
Concepts

Voice and Voice Group
A voice is a singular entity within a Voice
Group. A voice moves through a network
that is created in Nodal. The path taken is
determined by the connections, or edges,
between nodes in the network. Nodes are
indicated by circles, and edges are shown
as lines with arrowheads which indicate
direction of travel. The start of a journey

by a voice is indicated by a Voice Group
Triangle.
Voice groups may have more than one
voice if there is more than one starting
point allocated to that particular group, or
if a voice passes through a node with
parallel connections, causing two or more
voices to be spawned.
Voices trigger MIDI messages specified by
the values stored in the nodes and edges
of the network they are traversing. These
messages are then passed to a
designated Instrument, which is
associated with the voice’s Voice Group.
When a voice visits a node, the node fires
and lights up in the colour corresponding
to its Voice Group.
By default all voices are activated when
play is on. However their play state can
also be turned on and off independently of
Nodal’s play state by various methods
including external MIDI note triggers. In
this way, voices function like clips in
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Ableton Live. See pg 18 for details about
voice triggering.

•

Direct: the shortest path between
two nodes.

Node
A node is an object that generates MIDI
events when it fires, typically a note on
event. Parameters that determine the
pitch, velocity and duration of the note are
located in a node. The instrument that
sounds a note is governed by the voice
that visits the node. One exception to this
is where a node is set to Instrument
Change mode. This will force a voice
passing through a node to associate with
a particular instrument (which is
essentially defined as the MIDI channel
that note data is sent through).

•

Wormhole: an instantaneous
connection.

Like nodes, edges also generate MIDI
information. This takes the form of
continuous controller and pitchbend data,
which are specified in the edge inspector.
As the length of an edge defines the time
between notes, it is also used to define the
duration of continuous controller or
pitchbend changes.
Signaling

It is possible to view the number of times a
node has fired by choosing in the menu:
View > Show Node Counters
Edge

When a node fires the voice then passes to
a new node that is connected by edges to
the firing node. If a node has more than
one output edge, one or more of them
must be selected by rules within the node.
This is called signaling. There are three
possible signaling methods:
An edge signifies the duration in time
between two note events. It also signifies
the pathways by which voices traverse a
network of nodes. In Nodal an edge is a
one-way connection between two nodes
(for bi-directional connections, two edges
are required). The duration between note
events is proportional to the length of the
currently active edge. To identify them,
edges are assigned a colour. Edge colour
does not relate to voice colour. There are
three types of edge:
•

City block: here the edges are
given corners so that their length
quantizes with the grid divisions.

•

Sequential: output edges are
selected according to a fixed
sequence.

•

Parallel: all output edges are
selected simultaneously. This
spawns more voices.

•

Random: one output edge is
selected at random.

For more information see Inspectors /
Node pg. 24.
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Time and Space
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Go to start
Returns the network state to the initial
state:
•

Click the Go to Start button

Play / Pause
Toggles between play and pause modes:
•

Click the Play / Pause button or
press the Space bar

Play runs the network from the current
state. Pause suspends playback but does
not change the state of the network.
Time in Nodal is equivalent to distance.
The edit space can be divided according
to a grid. The grid has principal lines and
divisions. The distance between two
principals is equivalent to one beat. The
ratio between principals and divisions can
be set in the Document inspector.
By default, nodes entered into the edit
space automatically snap to the nearest
grid point. Similarly, edges snap to grid
points with city block edges. This ensures
that note timings are quantised to the grid
time.
It is possible to turn off the Snap to Grid
function, choose:
View >Turn Snap to Grid Off.
This will lead to timings that are not
referenced to a pulse or meter. The tempo
value still holds however as it represents
the time for a principal. But edge timings
will not necessarily consist of whole
number ratios of the beat or principal.

Transport and Timing

If Nodal is configured for MIDI
synchronization in slave mode then
playback will commence automatically
when the master application starts.
Conversely Nodal can act as a timing
master which will cause slaved software to
start playback. For more information on
synchronisation see pg 34.
Triggering Mode
The Triggering Mode button turns
triggering mode on and off. In Triggering
Mode Nodal will receive MIDI note
messages as triggering information. Voice
Group Triangles can be assigned a MIDI
pitch value, and if this pitch is received as
an incoming MIDI note on message, the
voice group associated with the starting
triangle will start to play. If a note off
message with the same pitch is received
the voice group will stop.
In Triggering Mode node editing is
switched off. This is to avoid confusion
that may result from the fact that MIDI
note input is also used for node editing.
For more information about triggering see
pg 18.
Timing Display Selection
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This is a menu than provides for three
different timing types:
•

Time (clock time) in:

Hours : Minutes : Seconds .
Milliseconds
•

Principles (elapsed principle
durations):
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To make a single selection:
•

click

To make a multiple selection:
•

click and drag

To make multiple discontinuous
selections:

Principles . Beats

•

Command-click (Mac) or,

•

•

Control-click (Windows) or,

•

Shift-click

Beats (elapsed beat durations):

Beats elapsed since play began.

Current time
This value indicates the amount of time
that the network has advanced since its
beginning. Time is specified in minutes,
seconds and milliseconds (not ticks). This
reflects the fact that Nodal can operate
outside of metrical time when the snap to
grid function is disabled (see Time and
Space below).
Tempo
To enter a tempo value:
1.

double-click on the number
specifying beats per minute

Multiple selection enables the
simultaneous entry of all node and edge
parameters in the inspectors (except for
continuous controllers). This is very useful
for real-time improvisation.
Zoom
To zoom in:
•

Zoom tool and click or,

•

Command + (Mac) or,

•

Control + (Windows)

To zoom out:
•

Zoom tool and Option-click (Mac)
or,

Tempo values can also be entered into the
Document inspector (see pg 24).

•

Zoom tool and Alt-click (Windows)
or,

Tools

•

Command - (Mac) or,

•

Control - (Windows)

2. type in a new value.

To return to the default view, choose:
View > Actual size
Selection
This tool is used to select objects in the
edit space including: nodes, edges, Voice
Group Triangles and text boxes.

Create Node and Edge
This tool has multiple functions.
To make a single node:
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•

click in the edit space.

To make a new node connected with an
edge from an existing node:
•

click and drag from the existing
node.

The direction of the connection is from the
old node to the new node.
To make an edge between two existing
nodes:
•
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•

select options from the Font
submenu

Inspectors
Inspectors can be selected by clicking on
the tabs at the top of the Inspector
window. Inspector selection also occurs
automatically based on context.
Document
The Document Inspector has three tabs;
Network, Style and Info:

click and drag from one node to
the next.

The connection will be confirmed by a
green ring around the second node.
Note that when creating city block edges
it is possible to flip them over by holding
down the Shift key before the mouse is
released.
Create Voice Group
The Voice Group Triangle indicates the
starting node for a voice when the
program is run.
To attach a Voice Group Triangle to a
node:
•

click on a node.

An instrument can then be associated
with the Voice Group Triangle by selecting
in the Voice Group Inspector (see pg 15).
Create Text Box
To create a text box:
•

Click then enter text by typing.

To change the font attributes:
•

select the text with the text tool,

•

right click or ctrl-click (Mac), Altclick (Windows) to call up a
contextual menu

In the Network tab under the heading:
Grid, the relationship between principals
and divisions can be set. By default, 1
principal equals 1 beat. However this
relationship can be set to any ratio. For
example, it is possible to have 2 principals
to 1 beat or 1 principal to 2 beats.
The number of divisions of a principal can
also be set. This allows for compound time
divisions to be created. The number of
divisions can be changed without
affecting the position of nodes that have
already been placed in the edit space. This
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is because the snap to grid function only
works on newly created or moved nodes.
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elements in Nodal to be assigned to the
colours you choose. Some colour settings
also contain a transparency value. There
are two presets in the menu in the
inspector. These are Dark the Nodal
default and Light which was the default in
earlier versions of Nodal.

In the Network tab under the heading:
Timing, the tempo, in beats per minute
may be set. Also ports for MIDI
synchronization may be allocated. For
more information about MIDI
synchronization see pg 34.
The Info tab has fields for Author, Title and
Comments. In addition it supplies
information on the composition of the
network.
Instrument

The Style tab contains a series of colour
pickers. This enables various visual
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Instruments can be created and assigned
in the Instrument inspector. To create an
instrument:
•

click on the + button.

When a new instrument is created it will
automatically be assigned the lowest
available MIDI channel. These parameters
can be changed by clicking the MIDI
channel buttons and selecting the Port
menu. Similarly, instrument names and
colours are automatically generated when
an instrument is created. These can also
be edited. You can give each instrument a
more descriptive name (e.g. Piano, Bass
Guitar, Melody, etc.) by changing the text
in the Label box.
Specific MIDI program change values can
be assigned to an instrument if required.
Bank messages can be assigned as well.
Note that more than one instrument can
be selected using shift select methods.
This is useful for setting all instruments to
the same MIDI port or to the same MIDI
program number.
Edge

This inspector is active only when an edge
has been selected using the Selection
tool, or when a node has been created
using the Create Node and Edge tool.
Edits made in this inspector apply to any
edges that have been selected or created
with the exception of continuous
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controller information which must be
entered on an object by object basis.
The Path section enables City Block,
Direct and Wormhole edge types to be
selected. There are two options for the
city block edge, enabling you to flip over
the direction of the bend in the edge. This
can sometimes make the layout of a
network easier to see, without changing
its behavior.
In the Continuous Controllers section it is
possible to send one or more continuous
controller (CC) or pitchbend MIDI
messages. The MIDI channel for these
messages is the channel of the instrument
assigned to a voice group. Note that in
cases where a voice group has more than
one voice and where a network might have
a number of edges with controller curves,
it is possible to generate conflicting
controller messages. Note also that the
Mute function does not stop pitchbend or
CC messages being sent.
There are three types of controller
messaging:
•

Single: creates a single CC
message that is sent prior to the
MIDI note on message. This is
useful for CC messages such as
pan, volume or sustain;

•

Linear: enables linearly
interpolated values drawn as lines.
Messages are sent continuously as
the edge is traversed, with the
value changing according to the
distance along the edge;

•

Cubic: enables cubic interpolated
values drawn as curves. Messages
are sent continuously as the edge
is traversed.

To select a messaging type:
•

Click on either the: None, Single,
Linear or Cubic tabs in the
Continuous Controllers section of
the Edge inspector.
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Clicking on the Single, Linear or Cubic
tabs will create an edit space in which you
can designate the CC type and draw the
curve or line in the case of Linear and
Cubic. Clicking on None will remove the
existing type from the Edge inspector.
Nodal has the facility to send high
resolution CC and pitchbend values by
combining Most Significant Byte (MSB)
and Least Significant Byte (LSB) MIDI
messages. The default is to send CC
messages at normal resolution by using
MSB messages only.
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To enter a value in the Single inspector
space:
•

Click and drag either the
horizontal slider or the rotary dial,
or:

•

Type in the value and the number
box below the slider, or:

•

Using an external MIDI controller,
send the CC value to Nodal. This
works so long as the slider, dial or
number box is selected.

To send normal resolution CC messages:
•

select the MSB CC type for the
MSB menu only

To send high resolution CC messages:
•

select the MSB CC type for the
MSB menu, then:

•

select the corresponding LSB CC
type from the LSB menu below.

Interpolators in the Linear and Cubic
inspector spaces are made from lines or
curves that can be edited by moving the
control points. The duration of the
interpolator will be the same as that of the
edge to which the curve is associated.
To move an existing handle:
•

Click and drag the handle
(horizontally for its placement in
time and vertically to set the CC
value), or:

•

Select the handle and using an
external MIDI controller, send the
CC value to Nodal.
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To create new handles:
•

Click in the line or curve edit
space.

To remove handles:
•

Select a handle by clicking on it
then

•

Press the delete key

Node

© 2019 SensiLab

Sequential signalling selects output edges
according to the sequence given by the
coloured tiles below the Signalling menu.
The tiles appear in the order in which the
edges were made. Numbers in the tiles
refer to the number of times the output
edge will be traversed before the next
output edge is traversed. In the figure
given above, the sequence is orange 7
times then green once. This pattern is
then repeated. The order of the tiles can
be changed by clicking and dragging
them. More tiles can be added by clicking
on the + button to the right of the tile field.

In Random signalling the output edges are
chosen with a probability weighted by the
numbers written on the tiles. In the
example given above the aqua output is 7
times more likely to be selected than the
orange one.
The Parallel signalling method sends a
voice along all output edges, thus
spawning multiple voices. The tile field
order does not affect output when parallel
signalling is selected.

The Node inspector is active only when a
node has been selected or created. Edits
made in this inspector apply to all nodes
that are selected, or a node that has just
been created.

The Note section of the Node inspector
allows the entry of pitch, velocity and
duration sequences. Notes can be edited
by typing, or by using a MIDI keyboard.
The format for specifying a note is simple:

The Signalling menu allows a choice of
three signalling methods:
•

Sequential

•

Parallel

•

Random

NOTE : VELOCITY : DURATION

The VELOCITY and DURATION
components are optional. Specification
may be absolute or relative, so the
following are all valid note specifications:
C3

C3:55

C3:55:150%
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+5
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-12:96:*2

+0:-10:50%

Relative and absolute values can be mixed
in a single note specification. For pitch
and velocity, relative values are added or
subtracted (+ or –). For durations, relative
values may also be multiplied or divided.
If you don’t specify a velocity or duration,
the current value of the playing voice is
used. For starting nodes, the default value
is specified in the Initial Voice settings in
the Voice Group editor.

You can also group notes together by
placing brackets around them. Different
brackets allow notes to be played
sequentially (round brackets ‘(‘ ‘)’), in
parallel (square brackets ‘[‘ ‘]’) or
randomly (curly brackets ‘{‘ ‘}’). Brackets
may be nested to as many levels as you
need. Some examples:

determined by the prefix: +0 always snaps
up in pitch, –0 always snaps down.
Notes listed without brackets are played
sequentially.
You can enter comments for a line in the
Note entry by prefixing them with // (like
comments in Java or C++). This can be
useful for documenting specific
sequences, or in a live performance when
you want to turn different sequences on or
off quickly.
While you enter note sequences, your list
is continuously parsed and checked if it is
valid. Notes will be automatically changed
to upper case, but you can enter them in
upper or lower case. An invalid sequence
will cause the Notes list border to flash
with an orange rectangle.

[C3 E3 G3] // play a C major chord
{+0:30 +0:60 +0:90 +0:120} // play the

previous pitch with velocity randomly
selected from the values shown
(+3:100:100% +5:100:200%
+7:100:400%) // play the three notes

sequentially with relative pitch increases
of +3, +5 and +7 semitones and increasing
durations
{
[+0 +3 +5] [+0 +5 +7] [+0 +7 + 12]
} // randomly play from the 3 specified

relative chords.

For relative chord sequences the first
pitch in the list becomes the new pitch for
the voice traversing the node, so in the
example above it remains unchanged
(since the first element of each chord is
always +0).
With the addition of scales in voice groups
(see page 30), +0 or –0 relative offsets will
always ‘snap’ to the closest legal note for
the chosen scale. In the case of a tie the
direction of snapping (up or down) will be

In the example above the closing ‘}’
bracket is missing (notice the orange
rectangle indicating the error). As soon as
a correct note list is entered, it is activated
for that node and will be used when
playing (there’s no need to hit RETURN or
any other key.
The Note editor also has syntax colouring
and auto-completion (hit the TAB key to
add default velocity and duration fields).
You may be interested to know that
internally Nodal takes your note
sequences and turns them into a selfcontained Nodal network, with the entire
network represented by a single node.
You can also enter notes using a MIDI
keyboard. To enter notes sequentially,
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play them one at a time. To enter chords
hold down the chord as you would
normally play it.
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Voice Group

There is also a Mute option that mutes the
node so that it doesn’t sound but it is still
active. Note that the Mute function does
not stop pitchbend or CC messages being
sent.
The Instrument Change feature forces a
voice passing through a node to adopt a
particular MIDI instrument. The
instrument can be set using the submenu
to the right of the checkbox. This
associates the voice with a new voice
group, ensuring that the voice retains its
new voice group and instrument when
visiting other nodes in the future.
The Message List in the Advanced MIDI
section enables raw MIDI messages to be
programmed. This can be used to send
custom MIDI messages such as system
exclusive messages. Values are entered
using hexadecimal notation, with each
value comma separated (e.g. 0xf0,0x42).
The box will flash red if you attempt to
enter a value that is not recognized. When
a voice visits a node, these lists are read,
and transmitted to the instrument
associated with the voice in sequence.
Appendix 3 (pg. 39) and appendix 4 (pg.
40) give decimal to hexadecimal
conversion and MIDI message information
respectively.
You can turn on display of the last note
played by each node using the following
menu selection: View > Show Node last
Note(s) Sent

The Voice Group inspector is active when
a Voice Group Triangle is selected or
created. Its primary function is to enable
an instrument to be associated with a
Voice Group. Additionally, triggering and
scale settings can be made here also.
In the Triggering section a Voice Group
Triangle can be assigned one or more MIDI
pitches that are used to turn the voice
group on and off independently of the play
button. Note that this feature is only active
when in Triggering Mode (see pg. 18)

To assign triggering pitches:
•

Click in the MIDI Pitch List

•

Type in the pitch values (comma
separated if more than one), or:

•

Send the pitch values from an
external MIDI source (such as a
keyboard or pad controller).
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Note that more than one pitch can be
assigned for triggering.

Triangle and a note off message
will turn it off, or:
•

Incoming triggering messages can be
quantized to various timing resolutions:
•

None: no quantizing, triggering
occurs as soon as the trigger note
or click is received;

•

Division: trigging is delayed until
the next grid division;

•

Principal: trigging is delayed until
the next grid principle;

•

Beat: trigging is delayed until the
next beat.

The maximum duration of notes that are
recognised by Nodal as toggle triggers
can be set in the Preferences window (see
pg. 34). The default Triggering toggle
timeout is 200 ms.
To turn on a voice using normal triggering
(assuming Nodal is running and is in
Triggering Mode):
•

To select triggering quantization:
•

Click on the Quantization tabs in
the Triggering section of the
Voice Group Inspector.

The note velocity for incoming MIDI
triggers can be used to scale the velocity
playback of the triggered voice. This
means that is you can trigger a voice to
play anywhere from soft to loud
depending on the velocity of the incoming
trigger note.

Click on the MIDI Velocity Scaling
check box in the Triggering
section of the Voice Group
Inspector.

Send an external MIDI note on
message with a corresponding
MIDI pitch value.

To turn off a voice using normal triggering:
•

Send an external MIDI note off
message with a corresponding
MIDI pitch value.

To toggle a voice on or off (assuming
Nodal is running and is in Triggering
Mode):
•

Send an external MIDI note on
message for which you have
assigned a MIDI pitch value in the
Triggering section of the Voice
Group inspector, and then, within
the Triggering toggle timeout
period, send the corresponding
note off message. Or:

•

Opt-click (Mac) or Alt-click
(Windows) on an assigned Voice
Group Triangle

To turn on MIDI Velocity Scaling:
•

Toggle triggering: where MIDI
notes with short durations turn a
Voice Group Triangle on and off.
Also Opt-clicking (Mac) or Altclicking (Windows) on a Voice
Group Triangle function as toggle
triggers.

There are two methods for triggering
voices:
•

Switch triggering: where a MIDI
note on will turn on a Voice Group
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In the Initial Voice section there are fields
for setting initial note parameters in the
case where adjoining nodes are set to
relative note parameter values. For more
information about relative note parameter
values see the tutorial pg. 14.
Pitches for the initial voice are normally
specified as absolute notes (e.g. C3),
however it is possible to specify an initial
pitch in terms of the current scale key (see
below).
Instead of setting an absolute pitch, you
can set a relative start pitch, specified by a
positive or negative number. This number
represents the number of notes in the
current scale from the middle root key
note. So for example if your scale is set to
C Major and the Initial voice Pitch is set to
+4 the actual initial pitch will be G3. If you
change the key to A, the initial pitch will be
E3.
This allows you to write a Nodal
composition using relative offsets in a
particular key and mode and then easily
change key or mode without having to
change any pitches.
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Muted voice groups are displayed with a
dashed outline as shown above and
individual voices highlight the nodes with
a striped pattern (rather than a solid
colour for non-muted voices).
Scales
You can confine the notes played by any
voice group to a specified scale,
consisting of a root key and mode.

When this option is activated any relative
notes specified by an offset will operate
within the chosen scale. You can change
the key or mode, even while a composition
is playing, for interesting harmonic
effects.
Note that the scale option only affects
relative pitch information. If you want to
play a note outside the scale, specify an
exact pitch (e.g. C3, D2, F#1, etc.) as these
will not be affected by the Scale settings.
A number of different modes are provided,
and selected modes are always saved with
your file so are transportable between
platforms and versions of Nodal.

The mute checkbox mutes all MIDI
information being sent by the selected
voice group. The voices will continue to
traverse the network allowing you to
temporarily silence particular instruments
or groups of instruments.
As a shortcut, you can also mute a voice
group by right-clicking on the voice group
icon and selecting “Mute” from the
context menu.
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Editing
All editing may be performed while Nodal
is running. This includes the creation of
nodes and edges, repositioning nodes,
and the editing of all parameters. Most
editing can be done on a single selection
or simultaneously on multiple selections.
Editing is suspended however when Nodal
is running in triggering mode.
Note Parameter Types
MIDI pitch and velocity parameters can be
set to any valid specified value. For
pitches these are C-2 to G-8 and for
velocity the values are 0 to 127.
Accidentals are only notated as #. Hence
C#3 is possible but Db3 is not. Pitch and
velocity can also be set as relative values
in semitones, such as –1 or +12. These
values are relative to the pitch or velocity
of the last node that the voice visited. For
example if a voice visited a node that
produced the pitch C3 and then a node
with an incremental pitch value of +12, the
pitch that will be produced is C4, 12
semitones or an octave above the previous
pitch.
Default duration values are set to a
percentage of the time between note
events as determined by edge length. As
there may be more than one output edge
from a node, and each may have a
different length, it is useful to set note
duration proportionally to edge length.
Relative percentage values can also be
set, e.g. -20% or +5%.
Duration can also be set to a fixed value.
The unit of measurement applied here is
the principal which, in most
circumstances, is equivalent to a beat. For
example a value of 2 will produce a note of
2 beats/principals regardless of any edge
length. Fixed duration values less than a
principal are notated with a decimal point.
For example .5 is half a principle and 1.5 is
1 and a half principals. Relative fixed
values can also be set, e.g. -0.1 or +0.1.
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It is possible to format parameter lists
with a mixture of fixed, percentage and
incremental values.
Keyboard Entry and Lists
Pitches and velocities can be entered
using a MIDI keyboard (see pg. 34 for
information on setting the MIDI input
port). Nodes can receive pitch and velocity
information if they are selected or when
they have just been created. All nodes
receive the same information when they
are selected simultaneously via multiple
selection.
Playing a single note enters a value for a
single pitch and velocity (as absolute
values). Playing a chord will enter all
pitches and velocities for the notes in that
chord, at once.
To add to an existing pitch or velocity list:
1.

hold down Shift then

2. play a note or chord on the MIDI
keyboard.
To enter only pitches or only velocities:
•

click on the respective field in the
node inspector.

Shift note entry also works when a single
field has been selected.
Continuous Controllers and Edges

Contextual Menus
Many settings and parameters found in
the inspector windows are directly
accessible in the edit space using
contextual menus. These can be accessed
by selecting the object that you wish to
edit, then right-clicking the mouse.
Cut, Copy Paste and Undo
You can apply these operations to any
object or multiple selection in the edit
space. It is possible to copy and paste
between documents.
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Preferences
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The designated template file will load
each time a new document is created.
This file will remain “Untitled” until you
save for the first time.

MIDI Input
The MIDI input port for keyboard entry is
set in:
Nodal > Preferences
A MIDI thru port can be set which enables
a sound to be heard when entering note
values with the keyboard.

MIDI Communication in
Windows
Nodal creates its own MIDI ports, Nodal
Input and Nodal Output, which can be
used to drive external synths and
communicate with DAW software such as
Logic Studio or Ableton Live (see the next
section for details on how to synchronise
Nodal with your DAW).
Defaults: Custom templates
It is possible to make templates that can
load automatically each time a new
document is created. To create a new
template:
1.

Create a new file and add changes
that you desire (such as
Instrument configurations, a
default starting network, or sync
settings).

2. Save the file. You may wish to call
the file something like “ my
template”.
To designate a file as a template:
1.

Open the Preference window,

2. Click on the Custom template
menu and select Choose…
3. Navigate to the file you wish to use
as a template and open.

MacOS has built-in support for inter-app
MIDI communication, so these ports
should appear automatically in any other
MIDI applications.
Windows does not have native support for
inter-application MIDI, but this is easily
addressed by installing software such as
MIDI Yoke (http://www.midiox.com). This
utility provides “virtual patch cable”
support to connect MIDI from different
applications together. Once installed the
Nodal Input and Nodal Output ports
should be visible to other applications

MIDI Synchronisation
Nodal can synchronise timing events with
another MIDI application either as a slave
or master timing reference. In Slave Mode,
Nodal will receive tempo and time position
from a host application via designated
MIDI ports. Master Mode is the opposite to
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slave, but it requires the slaved software
to be specifically set for external
synchronization.
Most DAW software will send and receive
MIDI sync and the process for setting it up
should be relatively simple. In most cases
it is desirable to run Nodal as a slave. You
can also synchronise two or more copies
of Nodal running on different computers,
during a live performance, for example.
Sync Settings in Nodal
To set Nodal for incoming synchronization:
1.

select the document inspector,

2.

select the Network tab,

3.

click a check box in the MIDI Sync Inputs
field corresponding with the desired MIDI
port.

Unlike many DAWs where an external sync
mode must be specified, is not necessary
to make any settings other than those
given above. If Nodal receives sync
messages in the designated port it will
automatically go into slave mode.

MIDI output ports, for sending
synchronization messages, can also be set
in the Document Inspector in the MIDI
Sync Inputs field.
On the Macintosh platform it is possible to
sync two copies of Nodal running on two
different computers. This is done by
connecting them using the Network ports
in Nodal. These ports can then be
connected over a computer network using
Core MIDI.
Please note that due to the nondeterministic nature of Nodal’s MIDI
generation (e.g. random nodes), seeking to
a particular time may not necessarily
result in the same notes being played each
time. For this and other reasons, Nodal will
always give highly accurate sync, but may
not necessarily respond to seek messages
in the way that DAW or linear editors do.
Sync Settings in another program.
As an example of how to set up software
acting as the Master sync source, the
correct settings and processes for
Ableton Live are given below. While the
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terminology may differ in other
applications these differences usually are
minor.
To send sync from Live to Nodal:
1.

Make sure both Nodal and Live are
open.

2.

Open the Preferences window in
Live.

3.

In the MIDI Ports section, for the
Live output port labelled Nodal
Input click the Sync box, as shown
below.

© 2019 SensiLab

This will enable Live to send MIDI sync to
Nodal. When play is activated in Live,
Nodal will start in sync. There is an option
to set a delay value. MIDI sync has a delay
inherent in the way it operates in interapplication environments. You might find
that you need to set a delay value
somewhere in the order of 20 – 40 ms
depending on your computer and
hardware configuration. The value
determines the duration of the delay that
Live will use in playing back tracks within
Live. This compensates for the delayed
messages received by Live from Nodal via
MIDI sync.
The best way to test the delay is to set up
a simple repeated clip in Live and
replicate this in Nodal. Set the port for the
instrument in Nodal to play an identical
sound (but on another track) in Live. Then
with Nodal synced play both the clip and
Nodal and adjust the MIDI Clock Sync
Delay value until you hear one note being
played.
Note that the MIDI Clock Type is set to
Song in Live in the example given here.
This is the best option to use in most
circumstances.
Since Nodal is a generative program, the
concept of a time-line is not as
straightforward as it is in other pieces of
software. Therefore, it may be the case
that Nodal may take a short time to find
the appropriate point to sync to in the
generative process.
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Appendix 1: Commands and Functions
Tool or Input

Keys or action

Function

Space bar

Toggles Play / Pause

Right-click

Contextual menus

Selection

Click and drag

Selects one or more objects

Selection

Shift-click

Multiple selection

Selection

Command-click (Mac),
Control-click (PC)

Multiple selection

Zoom

Click in edit space

Zoom in

Zoom

Option-click (Mac), Alt-click
(PC)

Zoom out

Create Node and Edge

Click in edit space

Makes a single node

Create Node and Edge

Click and drag from existing
node to anywhere

Connects an existing node to a
new node

Create Node and Edge

Click and drag from existing
node to existing node

Connects two nodes with an
edge

Create Node and Edge

Shift during click and drag

Flips city block corners

Create Voice Group

Click on a node

Creates a Voice Group Triangle
(a voices starting point)

Create Text Box

Click in edit space

Creates a box for entering
headings or comments

MIDI Note input

Single note when a node or
nodes are selected

Enters a new pitch and velocity
into a node/s

MIDI Note input

Chord when a node or nodes
are selected

Enters a list of pitches and
velocities into a node or nodes

MIDI Note input

Single note when a node or
nodes is selected and either
the Pitch List or Velocity List
field is selected in the Node
inspector

Enters a new pitch or velocity
into a node or nodes

MIDI Note input

Chord when a node/s is
selected and either the pitch or
velocity field is selected in the
Node inspector

Enters a list of pitches or
velocities into a node or nodes

MIDI Controller input

When editing Continuous
Controllers in the Edge
inspector.

Sets continuous controller
values for control points or
single value.
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Appendix 2: General MIDI Program Number
1 Acoustic Grand Piano
2 Bright Acoustic Piano
3 Electric Grand Piano
4 Honky-tonk Piano
5 Electric Piano 1
6 Electric Piano 2
7 Harpsichord
8 Clavi
9 Celesta:+12
10 Glockenspiel:+24
11 Music Box
12 Vibraphone
13 Marimba
14 Xylophone:+12
15 Tubular Bells
16 Dulcimer
17 Drawbar Organ
18 Percussive Organ
19 Rock Organ
20 Church Organ
21 Reed Organ
22 Accordion
23 Harmonica
24 Tango Accordion
25 Acoustic Guitar
(nylon):-12
26 Acoustic Guitar
(steel):-12
27 Electric Guitar (jazz):12
28 Electric Guitar
(clean):-12
29 Electric Guitar
(muted):-12
30 Overdriven Guitar:-12
31 Distortion Guitar:-12
32 Guitar Harmonics:-12
33 Acoustic Bass
34 Electric Bass (finger)
35 Electric Bass (pick)
36 Fretless Bass
37 Slap Bass 1
38 Slap Bass 2
39 Synth Bass 1
40 Synth Bass 2

41 Violin
42 Viola
43 Cello
44 Contrabass
45 Tremolo Strings
46 Pizzicato Strings
47 Orchestral Harp
48 Timpani
49 String Ensemble 1
50 String Ensemble 2
51 Synth Strings 1
52 Synth Strings 2
53 Choir Aahs
54 Voice Oohs
55 Synth Voice
56 Orchestra Hit
57 Trumpet:-2
58 Trombone
59 Tuba
60 Muted Trumpet
61 French Horn:-7
62 Brass Section
63 SynthBrass 1
64 SynthBrass 2
65 Soprano Sax:-2
66 Alto Sax:-9
67 Tenor Sax:-14
68 Baritone Sax:-21
69 Oboe
70 English Horn:-7
71 Bassoon
72 Clarinet:-2
73 Piccolo:+12
74 Flute
75 Recorder
76 Pan Flute
77 Blown Bottle
78 Shakuhachi
79 Whistle
80 Ocarina
81 Lead 1 (square)
82 Lead 2 (sawtooth)
83 Lead 3 (calliope)
84 Lead 4 (chiff)
85 Lead 5 (charang)

86 Lead 6 (voice)
87 Lead 7 (fifths)
88 Lead 8 (bass + lead)
89 Pad 1 (new age)
90 Pad 2 (warm)
91 Pad 3 (polysynth)
92 Pad 4 (choir)
93 Pad 5 (bowed)
94 Pad 6 (metallic)
95 Pad 7 (halo)
96 Pad 8 (sweep)
97 FX 1 (rain)
98 FX 2 (Soundtrack)
99 FX 3 (crystal)
100 FX 4 (atmosphere)
101 FX 5 (brightness)
102 FX 6 (goblins)
103 FX 7 (echoes)
104 FX 8 (sci-fi)
105 Sitar
106 Banjo
107 Shamisen
108 Koto
109 Kalimba
110 Bag pipe
111 Fiddle
112 Shanai
113 Tinkle Bell
114 Agogo
115 Steel Drums
116 Woodblock
117 Taiko Drum
118 Melodic Tom
119 Synth Drum
120 Reverse Cymbal
121 Guitar Fret Noise
122 Breath Noise
123 Seashore
124 Bird Tweet
125 Telephone Ring
126 Helicopter
127 Applause
128 Gunshot
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Appendix 3: Decimal to Hexadecimal Conversion table
Decimal Hex
0
0x00
1
0x01
2
0x02
3
0x03
4
0x04
5
0x05
6
0x06
7
0x07
8
0x08
9
0x09
10
0x0A
11
0x0B
12
0x0C
13
0x0D
14
0x0E
15
0x0F
16
0x10
17
0x11
18
0x12
19
0x13
20
0x14
21
0x15
22
0x16
23
0x17
24
0x18
25
0x19
26
0x1A
27
0x1B
28
0x1C
29
0x1D
30
0x1E
31
0x1F
32
0x20
33
0x21
34
0x22
35
0x23
36
0x24
37
0x25
38
0x26
39
0x27
40
0x28
41
0x29
42
0x2A

39

43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86

0x2B
0x2C
0x2D
0x2E
0x2F
0x30
0x31
0x32
0x33
0x34
0x35
0x36
0x37
0x38
0x39
0x3A
0x3B
0x3C
0x3D
0x3E
0x3F
0x40
0x41
0x42
0x43
0x44
0x45
0x46
0x47
0x48
0x49
0x4A
0x4B
0x4C
0x4D
0x4E
0x4F
0x50
0x51
0x52
0x53
0x54
0x55
0x56

87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

0x57
0x58
0x59
0x5A
0x5B
0x5C
0x5D
0x5E
0x5F
0x60
0x61
0x62
0x63
0x64
0x65
0x66
0x67
0x68
0x69
0x6A
0x6B
0x6C
0x6D
0x6E
0x6F
0x70
0x71
0x72
0x73
0x74
0x75
0x76
0x77
0x78
0x79
0x7A
0x7B
0x7C
0x7D
0x7E
0x7F
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Appendix 4: Continuous Controller Messages
Control Number
3rd Byte Value
(2nd Byte Value)

Control Function

Decimal

Binary

Hex

0
1
2
3

00000000
00000001
00000010
00000011

4
5
6
7
8
9

00000100
00000101
00000110
00000111
00001000
00001001

10
11
12
13
14

00001010
00001011
00001100
00001101
00001110

15
16
17
18
19
20

00001111
00010000
00010001
00010010
00010011
00010100

21
22
23
24
25
26

00010101
00010110
00010111
00011000
00011001
00011010

27
28
29
30
31
32

00011011
00011100
00011101
00011110
00011111
00100000

33
34
35
36
37
38

00100001
00100010
00100011
00100100
00100101
00100110

0x00
0x01
0x02
0x03
0x04
0x05
0x06
0x07
0x08
0x09
0x0A
0x0B
0x0C
0x0D
0x0E
0x0F
0x10
0x11
0x12
0x13
0x14
0x15
0x16
0x17
0x18
0x19
0x1A
0x1B
0x1C
0x1D
0x1E
0x1F
0x20
0x21
0x22
0x23
0x24
0x25
0x26

39

00100111

40
41
42
43
44

00101000
00101001
00101010
00101011
00101100

0x27
0x28
0x29
0x2A
0x2B
0x2C

Value

Used
As

Bank Select
Modulation Wheel or Lever
Breath Controller
Undefined

0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB

Foot Controller
Portamento Time
Data Entry MSB
Channel Volume (formerly Main Volume)
Balance
Undefined

0-127
0-127
0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB
MSB
MSB

Pan
Expression Controller
Effect Control 1
Effect Control 2
Undefined

0-127
0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB
MSB

Undefined
General Purpose Controller 1
General Purpose Controller 2
General Purpose Controller 3
General Purpose Controller 4
Undefined

0-127
0-127
0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB
MSB
MSB

Undefined
Undefined
Undefined
Undefined
Undefined
Undefined

0-127
0-127
0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB
MSB
MSB

Undefined
Undefined
Undefined
Undefined
Undefined
LSB for Control 0 (Bank Select)

0-127
0-127
0-127
0-127
0-127
0-127

MSB
MSB
MSB
MSB
MSB
LSB

LSB for Control 1 (Modulation Wheel or Lever)
LSB for Control 2 (Breath Controller)
LSB for Control 3 (Undefined)
LSB for Control 4 (Foot Controller)
LSB for Control 5 (Portamento Time)
LSB for Control 6 (Data Entry)
LSB for Control 7 (Channel Volume, formerly Main
Volume)
LSB for Control 8 (Balance)
LSB for Control 9 (Undefined)
LSB for Control 10 (Pan)
LSB for Control 11 (Expression Controller)
LSB for Control 12 (Effect control 1)

0-127
0-127
0-127
0-127
0-127
0-127

LSB
LSB
LSB
LSB
LSB
LSB

0-127

LSB

0-127
0-127
0-127
0-127
0-127

LSB
LSB
LSB
LSB
LSB
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0x2D
0x2E
0x2F
0x30
0x31
0x32
0x33
0x34
0x35
0x36
0x37
0x38
0x39
0x3A
0x3B
0x3C
0x3D
0x3E
0x3F

LSB for Control 13 (Effect control 2)
LSB for Control 14 (Undefined)
LSB for Control 15 (Undefined)
LSB for Control 16 (General Purpose Controller 1)
LSB for Control 17 (General Purpose Controller 2)

0-127
0-127
0-127
0-127
0-127

LSB
LSB
LSB
LSB
LSB

LSB for Control 18 (General Purpose Controller 3)
LSB for Control 19 (General Purpose Controller 4)
LSB for Control 20 (Undefined)
LSB for Control 21 (Undefined)
LSB for Control 22 (Undefined)
LSB for Control 23 (Undefined)

0-127
0-127
0-127
0-127
0-127
0-127

LSB
LSB
LSB
LSB
LSB
LSB

LSB for Control 24 (Undefined)
LSB for Control 25 (Undefined)
LSB for Control 26 (Undefined)
LSB for Control 27 (Undefined)
LSB for Control 28 (Undefined)
LSB for Control 29 (Undefined)

0-127
0-127
0-127
0-127
0-127
0-127

LSB
LSB
LSB
LSB
LSB
LSB

LSB for Control 30 (Undefined)
LSB for Control 31 (Undefined)

LSB
LSB

01000000

0x40

Damper Pedal on/off (Sustain)

65

01000001

0x41

Portamento On/Off

66

01000010

0x42

Sustenuto On/Off

67

01000011

0x43

Soft Pedal On/Off

68

01000100

0-127
0-127
<63 off,
>64 on
<63 off,
>64 on
<63 off,
>64 on
<63 off,
>64 on
<63
Normal,
>64
Legato
<63 off,
>64 on
0-127
0-127
0-127
0-127
0-127
0-127

LSB

0-127

LSB

0-127

LSB

0-127

LSB

0-127

LSB

45
46
47
48
49

00101101
00101110
00101111
00110000
00110001

50
51
52
53
54
55

00110010
00110011
00110100
00110101
00110110
00110111

56
57
58
59
60
61

00111000
00111001
00111010
00111011
00111100
00111101

62
63

00111110
00111111

64

Legato Footswitch

0x44
69

01000101

70
71
72
73
74

01000110
01000111
01001000
01001001
01001010

75

01001011

0x4B

76

01001100

0x4C

77

01001101

0x4D

78

01001110

0x4E

79

01001111

80

01010000

81
82
83
84
85
86

01010001
01010010
01010011
01010100
01010101
01010110

87
88
89

01010111
01011000
01011001

0x4F
0x50
0x51
0x52
0x53
0x54
0x55
0x56
0x57
0x58
0x59

41

0x45
0x46
0x47
0x48
0x49
0x4A

Hold 2
Sound Controller 1 (default: Sound Variation)
Sound Controller 2 (default: Timbre/Harmonic Intens.)
Sound Controller 3 (default: Release Time)
Sound Controller 4 (default: Attack Time)
Sound Controller 5 (default: Brightness)
Sound Controller 6 (default: Decay Time - see MMA RP021)
Sound Controller 7 (default: Vibrato Rate - see MMA RP021)
Sound Controller 8 (default: Vibrato Depth - see MMA
RP-021)
Sound Controller 9 (default: Vibrato Delay - see MMA RP021)
Sound Controller 10 (default undefined - see MMA RP021)
General Purpose Controller 5

---------

---

--LSB
LSB
LSB
LSB
LSB

0-127

LSB

General Purpose Controller 6
General Purpose Controller 7
General Purpose Controller 8
Portamento Control
Undefined
Undefined

0-127
0-127
0-127
0-127
-----

LSB
LSB
LSB
LSB
-----

Undefined
Undefined
Undefined

-------

-------
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0x5A

90

01011010

91

01011011

92

01011100

93

01011101

94
95

01011110
01011111

96
97
98
99
100
101

01100000
01100001
01100010
01100011
01100100
01100101

102
103
104
105
106
107

01100110
01100111
01101000
01101001
01101010
01101011

108
109
110
111
112

01101100
01101101
01101110
01101111
01110000

113
114
115
116
117
118

01110001
01110010
01110011
01110100
01110101
01110110

119

01110111
Undefined
----Controller numbers 120-127 are reserved for Channel Mode Messages, which rather than controlling
sound parameters, affect the channel's operating mode.
01111000
[Channel Mode Message] All Sound Off
0
--0x78
[Channel Mode Message] Reset All Controllers
01111001
0
--0x79
(See MMA RP-015)
01111010
[Channel Mode Message] Local Control On/Off
0 off, 127 on
--0x7A
01111011
[Channel Mode Message] All Notes Off
0
--0x7B
[Channel Mode Message] Omni Mode Off (+ all
01111100
0
--0x7C
notes off)
[Channel Mode Message] Omni Mode On (+ all
01111101
0
--0x7D
notes off)
[Channel Mode Message] Poly Mode On/Off (+ all
01111110
**
--0x7E
notes off)
[Channel Mode Message] Poly Mode On (+ mono
01111111
0
--0x7F
off +all notes off)

Note:
120
121
122
123
124
125
126
127

0x5B
0x5C
0x5D
0x5E
0x5F
0x60
0x61
0x62
0x63
0x64
0x65
0x66
0x67
0x68
0x69
0x6A
0x6B
0x6C
0x6D
0x6E
0x6F
0x70
0x71
0x72
0x73
0x74
0x75
0x76
0x77

Undefined
Effects 1 Depth
(default: Reverb Send Level - see MMA RP-023)
(formerly External Effects Depth)
Effects 2 Depth (formerly Tremolo Depth)
Effects 3 Depth
(default: Chorus Send Level - see MMA RP-023)
(formerly Chorus Depth)
Effects 4 Depth (formerly Celeste [Detune] Depth)
Effects 5 Depth (formerly Phaser Depth)

---

---

0-127

LSB

0-127

LSB

0-127

LSB

0-127
0-127

LSB
LSB

Data Increment (Data Entry +1) (see MMA RP-018)
Data Decrement (Data Entry -1) (see MMA RP-018)
Non-Registered Parameter Number (NRPN) - LSB
Non-Registered Parameter Number (NRPN) - MSB
Registered Parameter Number (RPN) - LSB*
Registered Parameter Number (RPN) - MSB*

N/A
N/A
0-127
0-127
0-127
0-127

----LSB
MSB
LSB
MSB

Undefined
Undefined
Undefined
Undefined
Undefined
Undefined

-------------

-------------

Undefined
Undefined
Undefined
Undefined
Undefined

-----------

-----------

Undefined
Undefined
Undefined
Undefined
Undefined
Undefined

-------------

-------------

** Note: This equals the number of channels, or zero if the number of channels equals the number of
voices in the receiver.

42

